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INTRODUCTION TO EMBARCADERO DBARTISAN

DBArtisan is an industry-leading database administration solution for managing Oracle,
Microsoft SQL Server, Sybase Adaptive Server, IBM DB2 for Windows, Unix, and Linux,
IBM DB2 for OS/390 and z/OS databases, and MySQL. Its cross-platform capability
allows users to efficiently manage heterogeneous database platforms easily using a
single front-end tool. Using DBArtisan, users boost their productivity by using a single
tool for all their databases, regardless of vendor.

PRODUCT BENEFITS

DBArtisan provides benefits to the following functions:

Database DBArtisan enables database administrators to accomplish

Administrator more with the time they have available in their workday. It
eliminates the tedious tasks associated with researching
schema dependencies when making object changes. Also
included are a host of utilities, which condense DBA tasks
taking hours or days down to minutes.

Developer DBArtisan provides additional administration functionality
to database developers over standard development
platforms. Using the powerful schema extraction, schema
migration, and publication wizards, developers can quickly
extract and move schema from development to other
environments, as well as create objects much quicker than
by using old-fashioned hand coding techniques.

ABOUT THIS GUIDE

This evaluation guide is intended to help you get started using Embarcadero’s
DBArtisan, the industry-leading solution for administering enterprise databases from a
single point of control. While DBArtisan supports current versions of Oracle, Microsoft
SQL Server, Sybase Adaptive Server, IBM DB2 for Unix, Windows, and Linux, IBM DB2
for OS/390 and z/OS, and MySQL, the examples in this guide are Oracle-centric. Unless
otherwise noted, all features and functionality highlighted in this guide are applicable to
all supported platforms.

After reviewing this evaluation guide, you will have the foundation you need to explore
the many features and benefits of DBArtisan. You'll have learned how to competently
manage the major database administration disciplines using DBArtisan’s standard
cross-platform console. In addition, you will have a solid understanding of DBArtisan’s
more advanced Space, Performance, and Capacity management capabilities.

This guide is divided into 10 sessions:
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Session 1:
Session 2:
Session 3:

Getting Started with DBArtisan
Schema Management
Security Management

Session 4: Space Management
Session 5: SOL Management

Session 6: Job Management

Session 7: Data Management

Session 8: Performance Management
Session 9: Capacity Management
Session 10: General Utilities and Tools

You can use this basic tutorial as a roadmap of product highlights, but also to help you
find your own path to explore DBArtisan.

Once you've started, you can select Help from the toolbar to find many additional
resources that complement and build on many of the activities shown in this brief guide.

) DBArtisan Help

B[ %]

5T & O

Hide FrintOptians

LContens | Index | Search | Favortes

[ e
@ DBetizan Tutorial
@ Applcation Basics
Using
= @ Datasource Managemert
& @ Supported Objects
& @ Object Editors
& @ Functionalty
= @ S0L Seripling
@ @ MySOL Dalasources
= @ Utiiies
= @ Tk
@ @ Addn Toals
® @ Capacity Analyst
= @ Perfomance Analyst
@ @ Space Analyst
@ @ Backup Analyst

Welcome to DBArtisan

Welcame to DBArtisan, the database adminisiration solution for managing IBM DE2 UDE for Linws, Unix and Windaws, 1BM DB2 UDB
forzi0S and OS1390, Microsoft SOL Server, MySQL, Oracle, and Sybase ASE databases

The table helow describes the majar sections af Help
Section Description
Explares the features and henefts of DBAMsan. YU leam how to make schera modifications, add
Tutorial
users and grant dalabase privileges. Finally, you explore some of the poweriul database utilties.
Provides conceptual information about DBAMISaN'S product design and navigation, as well as
datasaurce management and canfiguring the application
Provides tetailed information about using DBArtisan. Using DBAMisan shows howto use each
component ofthe application. Using kreaks each process and procedure imo simple step-hy-step
instructions.
Provides detailed information about the exiraction, migration and publication of your schema, the
loading and unleading of data, database searching, the use ofthe Script Execution Facility and Guery

“pplication Basics

Using DBAMisan

[Utlties Builder, the scheduling of processes, the hacking Up and restoration of databases, the use ofthe
Database Monitor, Database Manager, Resource Limils, and Logile
oot Frovides detailed information about DBArlisan's powerful taols to help you create, edit and manage

lyour develapment emironment,
0L Debugger [Provides detailed
for IBM DB UDE for Linux,
Unix, and Windows

about using the 0L Debugger far IBM DB2 UDB far
Linux, Unix, and Windows. Includes a step-by-step walk through to familiarize you with the features of
fthe Ernbarcadero SGL Debugger for I8M DBE2 UDB for Linu, Uniy, and Windows

Provides detailed information about using the Embarcadern SGL Debugger for Mierosoft. Includes a
step-by-step wialk through o farmiliarize you with the features ofthe Embarcadero SOL Debugger for
Microson

Provides tetailed information about using the Embarcaders SQL Debugger far Oratle. Includes a
step-y-step walk through 1o familiarize you with the features of the Embarcadero SGL Debugger for
Gracle

SQL Debudrer
for Microson

Embarcadern SQL Debugger
for Oracle

Provides detailed infarmation about using the DBAMisan PLISQL Profiler. Includes a step-by-step walk
through to familiarize you with the features of the PLISQL Profiler

Provides detailed infarmation about using the Embarcadera SQL Debugger far Sybase. Includes a
step-by-step walk through to Tamiliarize you with the features of the Embarcadero SQL Debugger for
Svhase.

Provides detailed information about using Caacity Analyst
Provides tetailed information about using Performance Analyst
Provides detailed information about using Space Analyst

DBArtisan PLISAL Prafiler
Embarcadern SQL Debugger
for Svbase

Capacity Analyst
Performance Analyst

Space Analyst

Backup Analyst Provides defailed information about using Backup Analyst

Formare information an how te use the online Help, see Using Help.t

comments: dacumentation@emb arcadsrs.com

SESSION 1: GETTING STARTED WITH DBARTISAN

DOWNLOAD AND INSTALL

You can obtain the latest version of the DBArtisan software from the Embarcadero
website at http://www.embarcadero.com/downloads.

NOTE: Trial versions of Embarcadero products can be either fully installed versions or
InstantOn versions. InstantOn is an application virtualization technology that lets you
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run an application using a single file, without running a full installation. When
downloading an InstantOn trial version, always use the Save option (as opposed to the
Run option), since the downloaded file is used to start the application during the course
of the trial period.

Provide the requested information and follow the steps indicated to download the
software and register the trial license. When you first install an evaluation copy of
DBArtisan, you can use the tool for 14 days. After that time, a permanent license is
needed.

INTRODUCTION TO EMBARCADERO DBARTISAN

The graphic below illustrates all the elements of the DBArtisan User Interface:

£ Embarcadero DBArtisan 8.7.0 - [Explorer1] Application Toolbars E]@

[D File: W Lkilities  Logfile  View Tools  Bookmarks  Analyst  Window HN _Ax
. BSOQLOS_Z (SCL Server 09.00,3042) = masker op_H - - E B i
Main Lo - 0 A B AIEE g g

Menu pate 7 et B \m'.‘\ - 'z Refresh iﬂclose

Dak Lask Dur| 4
Explorer Tree %‘“’I Current Data Source and Server At
+- i ROM Z_1(50L Server) 0 |
L SOL Server) ] [asda]s Cnline Ei26/2009 11:51:40 AM 73

Right Pane context [5Gl Server [ [asdas] Orline 4/4/2008 9:04:46 AM M
toolbar (5QL Server 8.0.2033 | [ [gemeni] w e
N

(SQL Server ,0,2039 I (MewTest] Online
+ FJay TORLABSTLO0_3 (501 Server) [ [PetraTest] orline Right Pane of Explorer i,
+ _'! TORLABSQLOS_1 (SQL Server 9.0.1399 ] _NewDixx Online Hia
= TORLABSQLOS_Z (3L Server 09.00,30 ] 123pac online 2/12/2008 9:01:53 &M Hj
+- B Filers [ 550421 anline 4/24[2002 3 18:55 AM M
+ o Server [Jab Crilineg 95,2007 7:44:33 &AM &
+&F Storage [ 222 Online 4/13/2009 3:35:45 AM s
* @ ] adina Cnline SI9Z005 8:17:10 AM {15
A i a8
- Performance ] aecsystem OnI!ne QI TZ008 &:36:46 AM {1
) 160 [ alexTest Cnline 5/5/20058 10:35:37 AM MfA
Tabs for open windows ' [ aloha@street Online 342005 8:56:15 AM M
. Aramescu Offling, Single User &/16/2009 2:55:01 PM MiA
+ _|!| TORLABTEOLT301 ] balanta Cnline 472005 4:28:40 AM {15
-5 MySQL Servers [ cases online 3(3/2008 10:57:36 AM MR
+-[7) Oracle Servers s | | cata Cnline 41172009 10:25:17 AM [T w
< > < >
4 . [[] Explorert x I
Cutput Messages x
€ 18:46:33.822 Program 05390 knowledge module loaded
o 18:46:39.0471 Program Oracle knowledge module loaded
€ 158:45:39.260 Program SOL Server knowledge module loaded
o 18:46:39.791 Program Sybase knowledge module loaded
€ 18:45:40.260 Program MySOL knowledge module loaded
€ 18:45:54.713 Program Connecting to datasource 'TORLABSALOS_2 using login 'sa'.. W
4 \,}) General | Build &Debug LEFind in Files 1 LEFind in Files 2 >
Ready Host: TORLABSOQLOS_2  TORLABSOLOS_Zimasterisa

START DBARTISAN

How you start DBArtisan depends on the type of application you are evaluating:
¢ InstantOn version — start the application by double-clicking the file you
downloaded.
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e Fully-installed version - The Start menu sequence for DBArtisan is always in the
form Programs > Embarcadero DBArtisan version identifier > Embarcadero
DBArtisan version identifier, where version identifier reflects the version you
are running.

To get started:

1. Run DBArtisan.

The first time DBArtisan starts, it displays a message indicating that it can
automatically detect and register your datasources. If you have installed and
used other Embarcadero tools, DBArtisan can find any active datasources being
used by those tools. In addition, DBArtisan provides a Discover Datasources
feature that automatically searches the DBMS configuration files on your system
for datasources that are not currently registered. The Discover Datasources
feature is a dialog box that contains a list that includes the name of the server or
instance and the type of DBMS, of all unregistered datasources found on your
network or local machine. Once discovered, you have the option to register
datasources for DBArtisan usage.

2. For the purpose of this Guide, dismiss the dialog. You will be registering a
datasource manually.

REGISTERING CROSS-PLATFORM DATASOURCES

The Datasource Registration Wizard walks you through the process of registering a
datasource for use with DBArtisan.
1. On the Datasource menu, select Register Datasource.
DBArtisan opens the wizard, initially prompting you for the DBMS type.

Datasource Registration

Information - IF
Select the database type, l’g"

Database Type

Connection Informatior

Security Parameters

Datasource Properties (3) IBM DE2 Universal Database

Datasource Group () Microsoft SQL Server
O MysqL
() Oracle

() Sybase Adaptive Server

[ Mext = ] [ Finish ] [ Cancel ] [ Help ]

2. Select Oracle as the database type and then click Next.
DBArtisan opens the next panel of the Datasource Registration Wizard.
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Datasource Registration

Information

Flease enter the connection information for the Cracle server, You can either select an entry From your
THSMames.ora file, or enter the information manually,

Database Type [use TS Names Alias

Connection Informatior

Instance Mame:

Datasource Mame:

Security Parameters Oracle Alias:
Datasource Properties Host:
Datasource Group
Part:
SI0yService Name: Type: (%) SERVICE_MAME () SID

[ < Back ][ Mexk = ] [ Finish ][ Cancel ] [

Help ]

3. Ensure that Use TNS Names Alias is deselected and provide the Host machine

name associated with an Oracle datasource.

4. Type a Port number. The default is 1521, but you can change it to wherever the

Oracle listener is set up.

5. Specify a Type of SERVICE_NAME or SID and enter the corresponding value in

the SID/Service box.

6. Inthe Datasource Name text box, type SAMPLE_DATASOURCE for the

purpose of this example.
7. Click Next.

DBArtisan saves your selections and opens the next panel of the Datasource

Registration Wizard.

Datasource Registration

Information

Please enter the security information used For this connection. You may also attempt a test connection to
ensure your information is correct,

Database Type
Connection Informatior

Security Parameters Hser b
Datasource Properties Password:
Datasource Group
Connect As: narmal

[] Auto connect? (Saves and encrypts passwaord)

[] connect using Windows Authentication

Test Connection. ..

[ < Back ” ek = ] [ Finish ][ Cancel ] [

Help

8. In User ID, type the user ID for the database.
9. In Password, type the user’s password.
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10. To save and encrypt your password, select Auto-Connect?.

11. Click Next.
DBArtisan saves your selections and opens the next panel of the Datasource
Registration Wizard.

Datasource Registration
Information - Ifz.ll
Flease select the properties for the current datasource [g)

Database Type
Connection Informatior

. #lnclude Search E]
Security Parameters Directories:

Datasource Properties

Datasource Group

[ < Back ” Mext = ] [ Finish ][ Cancel ] [ Help ]

DBArtisan’s SQL Editor supports directives similar to C compiler directives. This
panel lets you specify directories that will be searched when a #include
directive is encountered. You can leave the field blank for now.

12. Click Next.
DBArtisan opens the final panel of the wizard.

Datasource Registration
Information - Ifz.ll
Flease select the group Folder where the datasource will appear in the explarer tree, [g)

Database Type

Connection Informatior select the datasource group Folder:

Security Parameters
= [£= Managed Data Sources

[C DB2 Servers

Datasource Group [C3) M3 5L Servers
(23 MysQL Servers
|77 Oracle Servers
£ sybase servers

Datasource Properties

[ Finish l[ Cancel ] [ Help ]

13. In the Managed Datasources tree, place the datasource you are registering.
14. Click Finish.
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DBArtisan prompts you as to whether you want to connect to the datasource.
15. Click Yes.

DBArtisan offers the same easy-to-use Datasource Registration Wizard for IBM DB2,
Microsoft SQL Server, Oracle, MySQL, and Sybase connections. The connection
information only needs to be set up one time for each datasource and can be saved
locally or in a common datasource catalog for use by other Embarcadero products.
You can configure Embarcadero database applications to use a datasource catalog
stored in the system registry of your machine (local) or to use a datasource catalog
located in the registry of another computer (remote). This capability makes it easy to
share datasource catalogs among multiple users so that maintenance can be
administered from one location.

All Embarcadero database administration products share the datasource catalog, which
means that when you set up your datasource catalog using one product such as
DBArtisan, the same list of datasources is available in other Embarcadero Technologies
products. Any changes you make to the datasource catalog are reflected in all
Embarcadero database management products.

GENERAL USABILITY FEATURES

DBArtisan provides many “user in mind” features that make the product configurable to
meet individual needs and preferences. These features are designed to shave time off
the tasks that you perform many times on any given working day.

Retaining Datasource Explorer View Settings

1. At the top of the Explorer tree, click to expand the drop-down menu.
2. Select Retain View Settings.

+ [E| DB2 Servers {}%

[ InterbaseFirehird Servers
+-[7) M5 SQL Servers
+-[31 MysL Servers Show Only My Objects »
+-[23 Oracle Servers |
+-{7) Sybase Servers

Organize by Object Type
Show System Objects 3

Full Refresh

Expand All Groups
Collapse Al Groups

Collapse All Datasources

Retain Yiew Settings

The next time you open DBArtisan, the Explorer appears just as you left it.

Datasource Explorer Bookmarks

1. In the Explorer tree, right-click the datasource you registered.
2. Select Add Bookmark.
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5 TORLABSQL Eby Edit
m TORLABSOL
3!1 TORLABSSL _EM Unregister
i TORLABSCY | Redister Like
+-TF Filkers |
+ m Server
+-§F Storage \Ilg
+- ¥ Security S
+-r'y Databas g5
+- I Perfarm |
+ ﬁ‘g TORLAESGL Command 3
+- ) TORLABSQL —
4. Fg TORLABSYY | Refresh
+- ) TORLABTE] Filter. ..
+ MySQL Servers

+ Orarcle Servers Add bookmatk

3_‘.
[l TORLABSQL B change Group...
= ]
= ]

¥
¥
¥
¥
¥
¥

DBArtisan opens the Add Friendly Bookmark Name dialog box.
3. Click OK.

After Bookmarks are defined you can use them to easily navigate to commonly used
datasource resources via the main menu Bookmarks item.

Dj File Datasource Utlities Logfile  Wiew Tools | Bookmarks | Analyst  indow Help
Bookmark Manager...

Cracle 3 MyOracle
e

Setting Keyboard Shortcuts and Hotkeys

1. From the Tools menu, select Customize.
The Customize dialog box opens.
2. In the Customize dialog box, open the Keyboard tab.

Customize
Toolbars] Toals ] Dptinns] Application Yisual Style  Keyboard ]
Category: Set Accelerator for: B
[Fie | [Defaut | E)ﬁ
Commands: Current Keys:
1. ~
Active Script Cal 4

Close b |
DDL Editor 4
Exit [l

b
el — Press New Shortout Key: Reset Al
Drescription: ’7

Close:

The Keyboard tab can be used to set Keyboard shortcut hot keys for all areas of

DBArtisan functionality.
3. Click Close.
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Referencing Most Recently Used Datasources

4. From the File menu, select Recent Datasources, and then choose a datasource.
DBArtisan opens the datasource in the Datasource Explorer, ready to work with
an active connection.

D]El\e Datasource  Lkiities  Loafle  Wiew Tools  Bookmarks
Mew 3

= Open... Chrl+0

i
=

Print Setup...
[

& | ontions...

| Recent Datasources ’| | MyCracle !\ |

Datasource Explorer tree filtering

DBArtisan provides a number of ways to filter the Datasource Explorer tree, easing
navigation. During a DBArtisan session, you can use the Filter box at the top of the
Datasource Explorer to display only those objects whose name contains characters
typed in the Filter box.

3
=L MS S0L Servers

- ﬁETORLAESQLUS_I (S0L Server 10,00,16
+-BF Filkers
* Eh Server
+-# Storage
g Security
-ty Databases
#- B Performance
=031 Oracle Servers
- El& TORLABORCL11g_2 {Oracle 11,1.0.6)
=14 Schema
+ &g CODRUTA
+ A CosTIN
+ A scoTT
=1-[C3 Svbase Servers
= ﬁ'ﬂ' TORLABSY15_2 (Sybase Adaptive Serw
=1y Databases (45)
+-[] codruta

If you are interested in a more permanent filtering method, you can create filters at the
DBMS or datasource level. Filters are available under the Filters node for each
datasource.

] ?ﬂ TORLABSOLOS_1 (S0L Server 09,00,1399};
=B Filters (4)
19 1gnore System Objects (0)
1% shaw Only My Objects (0)
[#] % araclez {0y
[¥] B new Filter (0}
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Right-clicking in the tree and selecting Filter opens the Filters dialog. It lets you filter
out object types at the DBMS platform level. It also lets you create object filters.

Object filters can be object name-based, schema-based, or some combination thereof.
A named-based or schema-based filter consists of one or more ANDed conditions. You
also specify the object types to which the filter is to apply.

Filters m
4 Object Filkers W 3
-t} DBz
+1-] BF Ignote System Objects
a1 ] B show Only My Objects
[ nes
+-rpy Oracle
ik e
+-[] T Ignote System Objects View
+-[] B Show Only My Objects (o B Beisai
+-£F) MySQL )
+-r'f) Sybase (®) By Filter
4 Prodicates | oplohgse i "
‘ Property ‘ Dperatar | Yalue
Name j Lke j TOR, Hew
I~ Schema j Equals

Object filters are created at the DBMS or datasource level and can be enabled and
disabled for individual datasources.

The Filters dialog also lets you hide or display nodes based on object type. Node
filtering lets you filter out object types for all datasources of the same DBMS type.

Filters m
4 iy " oo Fiers "
=1} DB2
¢ b2 705 Select Al
=t} Oracle Unsslect Al
B Filkers
+] m Instance
- [¥] & storage

Control Files
Lg Directories
Redo Log Groups
% Rolback Segments
Tablespaces
+ ? Security
+-[7] & schema
+-[] 2 Performance
+-0F) M3 501
H-rE) My3qL
+-1F) Sybase

| ak. | | Cancel | | Help |A

In addition to any custom object filters you create, the Filters node also provides access
to two default filters: Ignore System Objects and Show Only My Objects. They can
be applied at the datasource level and cannot be deleted or modified.
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SESSION 2: OBJECT AND SCHEMA
MANAGEMENT

ADVANCED OBJECT CREATION AND MANAGEMENT

DBArtisan provides unparalleled database object management capabilities. Its
database platform- and version-specific graphical object editors and wizards enable you
to easily create, drop or alter any of your accessible database objects. The following
example walks you through creating and then altering a standard Oracle table object.
This concept carries across all of the supported object types, across all of the supported
platforms.

CREATING A TABLE OBJECT

1. On the Datasource Explorer, expand the Schema node of an Oracle
datasource.

2. Expand an individual schema, right-click the Tables node, and then select
Create.

DBArtisan opens the Table wizard and leads you through the process of creating a

table object.

Create Table Wizard - Step 1 of 10 [=15%
Properties @
Specify the table properties.
Property Walue
= Creation
Schema [
Mame [
= Table
Cache
Row Movement

Parallzl Degree
Farallel Instances
Percert Free

= Physical
Raow Organization HEAP
Lagging |
Table Campression O

[

| LCancel H Help |

3. Complete the wizard panels, and ensure that you create two or more columns in
the table.
4. Click Finish.
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DBArtisan lets you preview any and all generated scripts before you submit them to the
database. This is standard for all object-related scripts.

MAKING CHANGES TO AN EXISTING TABLE OBJECT

Changes to database tables, such as modifying column lengths, inserting new columns,
or deleting unneeded ones, can require dropping of a table. This requires knowledge
of the underlying object dependencies so that these dependent objects are rebuilt after
the table has been re-created. DBArtisan provides the ability to perform “extended”
table alterations by constructing a SQL script with the steps necessary to save off the
original data, create the new table, and populate it with the original data. Once these
steps are complete, all dependent objects are then rebuilt and permissions re-applied.

Following is a sample table change:
1. From the Explorer, Tables node, select the table you created in the previous
example.
2. Double-click the table or from the Command menu, click Open.

DBArtisan opens the Table Editor. The Table Editor provides access to basic
table properties, the list of table columns as well as any constraints, storage
parameters, space allocation, partitioning, table dependencies, object privileges,
table DDL and other attributes of the table. For example:

Colurins Properties | Indexes | Constraints | Storage Space Partition | Comment | Dependencies | Permissions | DOL View
T & dh Add Column = 5 Delete
# Mame Type Tull Default Comment E— Value
1 ) number(s... False E Column Attributes
2 bbb Floatia3) False Marme aaa
3 oo float{126) False B Datatype
4 ddd char(1} False Type nurber -
Width 5
Scale a
Unuzed I~
Allow Nulls r
E Encryption
Encrypted I~
r

Drefault  alue -
Comment

3. Select one of the columns you created in this table you want to modify.
Details for the column are shown in the Column Attributes area on the right side
of the pane.

In the Width or Scale text box, type a new value.

On the Table Editor toolbar, select the Alter button.

DBArtisan lets you preview the SQL script before you submit it to the database.
6. Close the Table Editor pane.

o &
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WORKING WITH OBJECT DDL

DBArtisan allows you to easily extract DDL for single or multiple objects using several
methods. The most straight-forward is described here:

1. On the Explorer, right-click the table you created earlier, and then select
Extract.
The DDL for all highlighted objects is extracted directly in a DDL Editor where it
can be altered, executed and saved to the database, with no intermediary steps

required.
=T X NN FR=N=RIN=A=AR ||
1 CREATE TAELE HR.JOES ]
2 (
3 JOB_TID WVARCHARZ (10) NOT NULL,
4 JOB_TITLE WVARCHARZ (35) NOT NULL,
5 MIN_BSALARY NUMEER (6, 0) NULL,
= MAX BSALARY NUMEER (&, 0) NULL,
7 CONSTREAINT JOB_TITLE_ NN
a CHECE ("JOB_TITLE" I8 NOT MNULL)
I
10 ORGANTIZATION HEAFP
11 TABLESPACE EXAMPLE
12 LOGEING
13 PCTFREE 10
14 PCTUZED 0O
15 INITRANS 1
16 MAXTRANS 255
17 STORAGE(BUFFER_POOL DEFAULT)
18 NOPARATLLEL
19 NOCACHE
20 / w

2. Close the PL/SQL Editor pane.

SESSION 3: DATABASE SECURITY MANAGEMENT

DBArtisan can help you efficiently establish and maintain database security and related
objects. Whether you are managing an existing production database or setting up a
new environment, you'll find consistent support across all of the supported platforms.

ADDING A NEW DATABASE USER

While this example focuses on creating a new Oracle user, the same wizard-driven
principle applies to all security objects (groups, roles, etc).

1. On the Datasource Explorer, expand an Oracle datasource, and then the
Security node.

2. On the Security node, right-click Users, and then click Create.
DBArtisan opens the User Wizard and leads you through the process of adding a
user.
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Create User Wizard - Step 1 of & @

Properties
Specify user name,

Properties

Froperty Walue

E Creation |
Harne [ T

B Defaults
Default Tablespace USERS -
Temporary Tablespace TEMP -
Profile DEF&ULT -

E Account
Identified By REGQUIRED_YES =

Password

=

[ Cancel ] [ Help ]

3. Provide the information on each panel of the User Wizard until you reach the
DDL View panel.
DBArtisan allows you to preview any and all generated scripts before they are
submitted to the database. This is standard for all object-related scripts.

4. Click Execute to create the new user.

DBArtisan opens the User Editor for the new user. The standard User Editor can be
used to manage existing database users as shown below.

GRANTING AND EDITING USER PRIVILEGES

Privileges can be easily granted, revoked, or viewed from within either of two editors
within DBArtisan; the User Editor, or the individual object editor (Table, Procedure, etc.)
The User Editor provides a tabbed interface, which can be used to view and modify
individual attributes of the user.

1. In the User Editor, open the Object Permissions tab.
2. Use the Object Type dropdown to select a set of objects such as tables or views.
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% Create

User hiff

[ alter 9 Drop.. 0%

SOL

Extract Bl‘] Migrate R}I Report <k Command - zReFrash JfClose

4

Properties | Roles | Guotas | Objects

MAME I
&CTIVE_THRESHOLDS
&CTIVE_THRESHOLDS
&CTIVE_THRESHOLDS
ADDRESS_DETAILS
ADDRESS_DETAILS
ADDRESS_DETAILS
ALARMS

ALARMS

ALARMS
ALERT_NOTIF_RECI...
ALERT_NOTIF_RECI...
ALERT_NOTIF_RECI...
ARFARE_MEM_MC
ARFAQE_MEM_MC_S
AQFOMS_QUEUE TA..

AR$ES_CBADM_ORD...
AR$ES_CBADM_ORD...
AR3ES_CBADM_ORD...

" Grant - 3 - | Dbject Type VIEW

OwHER
LT

REPOANCA
PERFCNTR_REPO_O
REFOANCA
AAALE

PERFCNTR_REPO_D...

REFOANCA
AAALE

PERFCNTR_REPO_O...

REFPOANCA
AAALE

PERFCNTR_REPO_O...

Qs

Qs

DM
05_CBADM
05_CBADM
05_CBADM

Chbject Permissions | System Permissions | DOL Visw

T | Owner [&l Owners] -

DELETE IMSERT SELECT

[

D:l Explurerl\\ A Users - Extoth76'system * I

I

3. Select a cell (corresponding to a specific object type and a specific permission,
such as DELETE), and then click Grant.
A distinctive icon is shown in the cell, indicating that this permission is granted.
You use a similar process to revoke privileges and perform other permission-

based activities.

4. On the Object Editor toolbar, click Alter to implement the changes.

SESSION 4: SPACE MANAGEMENT

Managing space is vital to ensuring the availability and performance of your databases.
DBArtisan incorporates many built-in space features that let you smartly manage and
exploit all aspects of your database’s storage. The following example walks you through
a review of DBArtisan’s built-in support for reporting Oracle tablespace storage and
space data.

BUILT-IN SPACE MANAGEMENT

While this example is specific to Oracle tablespaces the same concept applies to all of
the supported platforms.

1.

3.

On the Datasource Explorer, expand any Oracle datasource.
2. On the Oracle datasource, expand the Storage node, and then select

Tablespaces.
Right-click any tablespace listed in the right pane of the Explorer window, and
then click Open.

Embarcadero DBArtisan opens the Tablespaces Editor.

On the Tablespaces Editor, click the Storage tab.
The Storage tab displays and lets you edit the tablespace extent limits.

Embarcadero Technologies

19



Datafile | Storage | Space | Map | Objects | Quatas | DOL
Tablespace: Status: Contents:
TOOLS s | |OMLINE PERMAMNENT v
Extents Extent Detail
e ettt BY KB Type | MName | FielD | ExertlD | BlockiD | Blocks | Bytes [~
Mest Extent: 0 KE TABLE RiaN.DE g 1] 9 8 Eh536
INDE= RiaN.DE_P g a 17 8  EB5536
Minimurn Estents Size: |64 KE INDEX RMAN.DE_... g 0 25 g B9E36
TABLE RbaN.CONF g a 33 8  EB5536
Mirimum E stents: 1 INDE= RbAN.CON... g a 41 8 BE536 |w
M aimum E stents: Extent Management
Percent Increase: 1] Type: || oraL
[Dictionary or Local)
Segment Management Allocation Type: |41 TOALLOCATE
Automatic [&wto, Uniform, or User]
el a9z g;‘z!ssg::'? Extent Size: KB

Changes to this tab enable the Alter function on the Tablespace Editor toolbar.

5. On the Tablespace Editor, click the Space tab.
The Space tab displays a graphical view of the Free space and Fragmentation Index
for the target tablespace.

Dratafile | Storage | Space | Map | Objects | Quatas | DDL

Tablespace: Status: Contents:
TOOLS s | [OMLIME PERMANENT v
Free Space Fragmentation Index [F5FI)

The F5FI measures free space fragmentation on a
telative scale of 100. Its critical determinant is the
zize of the largest extent compared to total free
zpace. A high score indicates low fragmentation
and, therefore, is desirable.

100% “Y'ou should minimize fragmentation to ensure that
. . any object can acquire a free space chunk large
[ other Free Sections Bl Largest Free Section enough to accommodate its next extent. To
reduce fragmentation, you can coalesce adjacent
| | free blocks and/or reorganize the tablespace.

Free Space 472 3E9
Used Space 808 631 Current Score: 100
Total Space 1280 10,00

6. Finally, on the Tablespace Editor, click the Map tab.
The Map tab displays a color-coded map of the objects contained on the
tablespace.
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Datafile | Storage | Space | Map [ Objects | Quatas | DDL

Tablespace: Status: Contents:
|To0LS [se] [oMLINE | PERMANENT [¥]
~
Space Info View By -
Total: 1000ME Free:  3.63MB @) Dbiect Type [ Leserd. | Disply. |
Used: 631MB % Free: 3680% OFEstent Pioblems [ FitInwindow ][ FulScieen || PintMap |
Map

[(] 1il [)]

Object Demographics

Mame | Extents| Blocks| Bytes| Type | Initial Extent| Newt Extent| Percent Increase|!
1 HR.PARTITIONED_HASH_IDX1.P3 1 8| B5536/ INDEX PARTITION BEA36 [NUILL] [MULL!
2 RMAN.AL 1 8| 65536 TABLE B5A36 [NUILL] [NULL
3 RMAN.AL_I_2 1 8| B5536/INDEX B5A36 [NUILL] [NULL[[V]
[( ] 1l | [ )]

The map segments are proportional to the actual size of the objects on the
tablespace.
7. Close the Tablespaces Editor pane.

ADVANCED SPACE MANAGEMENT (ORACLE AND SQL SERVER
ONLY)

For advanced space analysis and management, DBArtisan’s optional Space Analyst
component contains sophisticated diagnostics to help you pinpoint all space-related
problems in your database, as well as an intelligent reorganization wizard that can
reorganize all or selected parts of your database.

Embarcadero Space Analyst

1. On the Analyst menu, select Space Analyst.
The Space Analyst launches in the DBArtisan workspace.
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=PSRN N A A |

Database Overview

I HDEX (KB
[ L OBSEGMENT (KB)
[ TABLE (KE)

I Cther

[ TABLE PARTITION (KB) 73,024

124 228 orage Percent (User Obje
33,024
252,160

23,744

4 Dratabase Overview r Data Files r Tablespace Map r Tables r Indexes

Tablespace Fragmentation Overview

-

Fragmentation Index

Fragmentation Index

Tablespacels)

Tablespace Space Overview

Total Space Allocation

w
=)
=]

.
=1
=]

=]
=]

(S
=]
=

Total Space(MB)

o
=]

i}

Tablespace(s)

Tablespace Objects Overview

Tablespace Mame Table {ME)
AAAAATRS 5.56
Applabs 0.50
CwMLITE 438
DED 2
DBO_TEMP a
DRSYS 356
ExAMPLE 211.50
EXTOTEYE 013
GDROPTEST 013
IND 0.38
MEwL/APPE E n

Indesx {ME)
18.50
a
E.56
1.63
a
E.13
11.56
013
a
0.06

4 [0 Explorert L

Tablespaces - Extotb76!system \ Ij Space Analyst - [Extotb76%system] I

Clf#s

]
Dl |
>

Embarcadero’s Space Analyst provides sophisticated diagnostic capabilities to
troubleshoot bottlenecks and performance inefficiencies that result in poor
space management.

Please see the DBArtisan online help for a detailed walkthrough of all available

features and fun

ctionality.

2. Close the Space Analyst pane.

SESSION 5: SOQL MANAGEMENT

DBArtisan provides powerful visual tools for creating and analyzing complex SQL
statements and server-side code objects. The following examples walk you through
DBArtisan’s Visual Query Builder, feature-rich ISQL facility and some of the advanced
analysis and debugging capabilities provided by the Embarcadero SQL Debugger and

SQL Profiler.

VISUAL QUERY B

UILDER

1. From the Tools menu, select Query Builder.

DBArtisan opens the Query Builder.

2. Inthe Tables/Views tab, right-click a table or view and select Add.
3. Inthe window that opens, select the columns to return in the result. For example:
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x|
_I'ROWID"
_VENDOR,_LOAD D
ASERVICE NIV

AORIGIN CD
_IDESTINATION CD
_JLOCKOUT TIME
_IEVAILABLE TIME

_IMONDAY TRANSIT DAYS
_ITUESDAY TRAMNSIT DAYS
_ITWENDESDAY TRANSIT DAYS
_ITHURSDAY TRANSIT DAYS
_FRIDAY TRANZIT DAYS
_JSATURDAY TRANSIT DAYS
_ISUMDAY TRANEIT DAYS

Query Builder generates the query text in the lower SQL window.

1 SELECT BSYSTEM.ANH.SERVICE NM,
z SYSTEM. ANH. ORIGIN_CD

3 FROM GSYSTEM. ANH
4
5

You can build advanced queries using the options supplied on the DML tab.
You choose the type of query (SELECT, INSERT, and so on) using the dropdown
on the Query Builder toolbar.

4. After the query is built, click the Execute button (green arrow) on the Query
Builder toolbar.
Query Builder displays results in the lower SQL window.

5. Close the Query Builder pane.

ISQL WINDOW

DBArtisan offers a fully-featured SQL editor. In addition to basic text processing
features, the editor environment offers testing/debugging and execution facilities. In
combination with supporting features, the ISQL editor eases and speeds up the process
of developing working scripts.
1. On the File menu, click New, and then ISQL.
DBArtisan opens the ISQL Editor window. You can add SQL code via your
method of choice (free-form typing, retrieve from a file, paste copied code, etc.).

=15 b O &h-0 8 ARA Al
1 gelect * from Jobs
2

Auto Commit Off CUA \TORLABORCL10g_2\system Line 2 Cal1

Dj Explorerl l El QueryBuilderl * - [TORLABORCL10g_2\system] Hﬂ SQL1 * - \TORLABORCL10g_X\system > ﬂ

2. Experiment with the automated error detection and coding assistance as follows:
e Type SELECT * FROM and stop typing. Note the error condition.

1® SELECT * FROM
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By default, DBArtisan runs a syntax check any time there is an interval of 1.5
seconds between keystrokes. You can also disable automatic syntax checking
and only run a check when you manually initiate it. Syntax error annotation
persists until you correct the problem.

e This time type a fragment that includes the name of a nonexistent object,
SELECT * FROM NON.OBJECT, for example. For now, ignore any popups.
The warning condition is a result of on-the-fly semantic validation. DBArtisan
notifies you when a script contains a reference to an object that DBArtisan
cannot resolve.

e Type SELECT * FROM followed by a space and then stop typing. If no
popup appears, press CTRL+SPACE. The Code Complete suggestion box
lets you select from objects or object name components such as databases or
schema. This feature saves keystrokes and minimizes typing errors. See the
online Help for full descriptions of these features.

The ISQL Editor window includes the following features and options:

The ISQL window highlights all platform-specific and general keywords, and
provides options for SQL code formatting and analysis.

Once code is executed you have control over whether your transaction is
committed or rolled back from the database.

For all open ISQL windows, there are also options for connection locking,
scheduling, executing your code across multiple datasources, explain plan
generation, and SQL Tuning.

Press F8.

DBArtisan opens the Query Option dialog box that lets you set platform-specific
query options to immediately determine if your code is optimized. For example,
when connected to a SQL Server datasource, the Query Options dialog offers
the following options.

Query Options

Option Walue oK

= Query Analysis -
Mo Count [}
Ma Exec [}
Force Plan O -

s

Statistics 1/0 O
Statiztics Time O -m
Parze Only D —

= Arithmetic
lgnare Overflow [}
Abart On Overflow [#] j

Either close the Query Options dialog and then the SQL Editor window or enter
a valid query in the ISQL editor and then execute your query by clicking the
Execute button.

B

5. When complete, ensure that only the Datasource Explorer window is open.
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SQL DEBUGGING, ANALYSIS AND TUNING

To analyze and debug your SQL code, DBArtisan provides cross-platform SQL code
debuggers, and for your Oracle databases, a robust PL/SQL code profiler that helps
you to pinpoint and eliminate “hot spots” within poorly running server-side code. To
ensure code efficiency, the ISQL window provides tight integration with Embarcadero’s
SQL Tuner, so you can perform multiple “test then tune” iterations without having to
leave an open ISQL window.

SQL DEBUGGING

While this example is specific to Oracle PL/SQL Debugging, the same interface and
functionality applies to all of the supported platforms.

1. On the Datasource Explorer, expand any Oracle datasource node.

2. On the Oracle datasource, expand the Procedures node.

3. Inthe right pane of the Explorer, right-click any stored procedure, and then
select Debug.

He P RTR R CARLIUSRERE. SEHENE IR
CREATE ©OFE REPFLACE PROCEDURE SCOTT.TEST
Is

TBEGIN
DEMS_OUTPUT. PUT_LIME ("TEST')
) END ;
/

[= =R B T T N PV S

4. If prompted, enter any input parameters in the Procedure Execution input
window and then click Continue.

After the SQL Debugger interface is displayed you can step through code, step into
dependencies, set and watch variables, and even perform basic code profiling for each
line of executed code.

Please see the DBArtisan online help for a detailed listing of all available SQL features.

SESSION 6: JOB MANAGEMENT

DBArtisan freely integrates with the Microsoft Windows Task Scheduler, which allows
you to virtually schedule any task to run on your own computer whenever and how often
you'd like. While this example is specific to an Oracle table redefinition, the same
concept applies to any job or script that can be scheduled.

ADVANCED JOB MANAGEMENT

To schedule a job, do the following:

1. On the Explorer, expand any Oracle datasource.
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2. On the Oracle datasource, expand the Tables node, and then right-click any
table.
3. Select Extract.

B2 b w[E ¥4 | A® sa ARA I R
1:  Belecfschedue sqLpaue
7 ; pl.first _name
S , pl.dob
4: , nl.first name
i , nl.last_name
6: , al.admission_time
7: from eradmin.patient pl
8: , eradmin.nurse nl
9: , eradmin.admission al
10: where al.admission_id - 1 < 1000
11: and al.patient _id = pl.patient_id
12: --and al.admitting nurse_id = nl.nurse_id
13: and length(nl.last name) = §

4. From the ISQL window toolbar, click Schedule.
18]

The Schedule Action dialog box opens where you can provide a name, set notifications,
and specify an output directory for the new job.

Schedule Action Dialog

Specify Information for Notification of Job Completion
Job Mame:
150LScheduler031 6200711 27204M)|

Job Dezscription [Email subject ling):
1505 cheduler

EMail Address(es]: [Separated by semi-colons]

Met Send: [Metwork user names separated by semi-colons]

Aection Output Directany:
CADOCUME ™1 \davidtLOCALS 15 Temgh [eee)

[‘/ oK ] ’% gancell ['? Help ]

5. After you have completed the dialog box, click OK.
6. To monitor and administer your new job, on the Oracle datasource, right-click
the Instance node, and then select Oracle Job Queue.
This opens the Windows Job Scheduler dialog. For the purposes of this exercise, you
can either finish scheduling the task and inspect the results when it completes, or you
can click Cancel to proceed to the next session.

SESSION 7: DATA MANAGEMENT

DBArtisan provides comprehensive facilities to help you manage the data in all of your
databases. A visual data editor helps you add, change, and delete data from your
tables with all referential integrity enforced. You can create insert statements for tables
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using current data and also extract data as XML documents for certain databases.
Rounding out its rich Schema Management capabilities, DBArtisan also allows you to
migrate schema objects and associated table data from one database server to
another, across the same or different platforms.

VISUAL DATA EDITING
To start the Visual Data Editor, do the following:

1. In the Datasource Explorer, right-click any table or tables, and select Edit Data.
DBArtisan opens the Data Editor Filter.
2. In Columns, select the columns that are to be included in the editable data.

Data Editor Filter

Construct a Select Statement to filter data for the Data E ditor

Columns:

(v]"ROWID"

W/DOCTOR_ID 4]
ALAST_NAME Clear Al
(WIFIRST_NAME _—J
(VIPAGER

Where:

doctod_id < 10

Select Statement:

SELECT T."ROWID", T.DOCTOR_ID, T.LAST_NAME, T.FIRST_NAME,
T.PAGER FROM ERADMIN.DOCTOR T WHERE doctor_id < 10

v oK |x Qancel| P Hep |

You can also filter the editable rows by including your own SELECT statement.
3. Click OK.

In Live mode all changes are applied to the database when you move off of an

updated or inserted row. Deleted rows are immediately removed from the

database. Batch mode allows you to make changes and then save all when all

are complete. Mode is controlled by a dropdown in the Data Editor toolbar.

4. Experiment with editing your data, and when complete, on the Data Editor
toolbar, click the Execute (blue arrow) button.

DBArtisan commits your changes. Regardless of mode, all of the generated DML
statements are viewable in the lower SQL window.

M 4 v M S5QL Y Histary

1 -— Btatements To Be Executed: 2]

2 ——

3 UPDATE HR.JOB_HISTORY SET JOB_HISTORY.EMPLOYEE_ID=101 WHERE JOE_HISTORY.
"ROWID"="AAAHM/AAFAAARBUAAA' AND JOE_HISTORY.EMPLOYEE_ID=10Z AND
JOB_HISTORY.START_DATE=TO_DATE ("01/13/1993 12:00:00 AMT, T"MM/DD/YYYY

HE1Z:MI:g8 AM') AND JOE HISTORY.END DATE=TC DATE ('07/24/1995 12:00:00 AMT,
TMM/ DD/ YYYY HH1Z:MI:S§ AM') AND JOB_HISTORY.JOE_ID="IT FROG'
4 COMMIT a
g | v
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5. Close the Data Editor pane.

WORKING WITH TABLE DATA — CREATE INSERT STATEMENTS

1. On the Datasource Explorer, select any Oracle datasource.
2. On the Oracle datasource, expand the Tables node.

3. Inthe right pane of the Explorer window, right-click any table, and then select

Create Insert Statements.

DBArtisan opens the Create Insert Statements dialog box.

Create Insert Statements

Construct a Select Statement to filter data

Columns:

(VIADMISSION_ID |
[VIADMISSION_TIME (7

VINURSE_ID
VIPATIENT_ID ‘
VISCOTT WALZ b4

Where:

Select Statement:

SELECT T.ADMISSION_ID, T.ADMISSION_TIME, T.RELEASE_TIME,
T.RELEASE_COMMENTS, T.NURSE_ID, T.PATIENT_ID,
T.SCOTT_WALZ FROM ERADMIN ADMISSION T

IV Include owner information in Insert statements

™ Set row count

VIRELEASE_TIME ! Cloar All
VIRELEASE_COMMENTS JEe

VvV oK | X coee | P e |

4. In Columns, select the columns you want to include in the INSERT statement.
5. You can also filter what rows are included by adding your own WHERE clause.

6. Click OK.

The resulting INSERT statements are created and presented in an active ISQL window.
At this point they can be executed immediately, scheduled to later or saved. Note that
all extracted INSERT statements can be run against the same or different databases

containing a similar schema.
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=y b G & A RA]E A

1 ——
2 —— TAELE INZERT STATEMEMNTS
3
4

INSERT INTO HR.JOE_HISTORY ( JOE_HISTORY.EMPLOYEE_ID,
JOE_HISTORY.START DATE, JOB_HISTORY.END_ DATE, JOB_HISTORY.JOB_ID,
JOE_HISTORY.DEPARTMENT ID |

5 WALUES ( 113, TO DATE('11/04/2006 12:43:24 DMT,
TMM/DD/YYYY HH1Z:MI:Sg AM'), TO DATE ("01/15/2007 12:43:24 DMT,
TMM/DD/YYYY HH1Z:MI:Sg AM'), 'TEU MAN', 270 )

& £

7 INSERT INTO HR.JOE_HISTORY ( JOE_HISTORY.EMPLOYEE ID,

JOE_HISTORY.START DATE, JOB_HISTORY.END_ DATE, JOB_HISTORY.JOB_ID,
JOE_HISTORY.DEPARTMENT ID |

8 WALUES ( 102, TO DATE('01/13/1893 12:00:00 AMT,
TMM/DD/YYYY HH1Z:MI:Sg AM'), TO DATE("07/24/1998 12:00:00 AMT,
TMM/DD/YYYY HH1Z:MI:S8 AM'), 'IT PROG', &0 )

9 /

10 THSERT TNTO HR.JOE_HTSTORY ( JOB_HTSTORY.EMELOYEE_TD,

JOE_HISTORY.START_DATE, JOB_HISTORY.END_DATE, JOB_HISTORY.JOE_TD,
JOB_HISTORY . DERPARTMENT_TD )

11 WALUES ( 101, TO DATE('0%/21/1989 12:00:00 AMT,
TMM/ DD/ YYYY HH12:MT: 85 AM'), TO DATE ("10/27/1993 12:00:00 AMT,
TMM/ DD/ YYYY HH1Z:MT: S5 AM'), TAC ACCOUNT', 110

12 /

7. Close the editor pane.

WORKING WITH TABLE DATA — EXTRACT DATA AS XML

This feature is available for Oracle 9i and SQL Server 8.1. The following example is
specific to Oracle 9i, but the concept applies to SQL Server 8.1 as well.

N —

On the Datasource Explorer, expand any Oracle datasource.

On the Oracle datasource, expand the Tables node.

3. Inthe right pane of the Explorer window, right-click any table listed, and then
select Extract Data as XML.

4. Select the columns to include in the SELECT statement.

5. You can also filter what rows are included by adding your own Select statement.

6

Click OK.

The resulting XML document is created and presented in an active XML Editor. At this
point the document can be saved in XML format.
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@ ia Close

1 <7xml version="1.0"7> -
2 %<ROWSET>
3 [ <ROW>
4 <ROWID>AAAHM/ AAFAAAAB=ARRL/ROWID:>
5 <EMPLOYEE_ID>113</EMPLOYEE_ID>
6 <START_DATE>11/04/2006 12:43:Z24 PM</START_DATE>
7 <END_DATE>01/15/2007 12:43:24 PM</END_DATE>
8 <JOB_ID>PU_MAN</JOB_ID>
9 <DEPARTMENT_ ID>270</DEPARTMENT ID>
10 oS ROWE
11 [ <ROW:>
1z <ROWID>AAAHM/ AAFAAAABUAAA</ROWID:>
13 <EMPLOYEE_ID>102</EMPLOYEE_ID>
14 <START_DATE>01/13/1993 12:00:00 AM</START_DATE>
15 <END_DATE>07/24/1998 12:00:00 AM</END DATE>
16 <JOE_ID>IT_PROG</JOB_ID>
17 <DEPARTMENT_ ID>A0</DEPARTMENT ID>
18 - </ROW>
19 [ <ROW>
20 <ROWID>AAAHM/ AAF ARAABUAAR</ ROWID>
21 <EMPLOYEE_ID>101</EMPLOYEE_ID>
22 <START DATE>09/21/198% 12:00:00 AM</START DATE> i
4 D:l Exp\nrerl\\ T %ML Editor: JOB_HISTORY ] [

7. Close the editor pane.

ADVANCED DATA MANAGEMENT — SCHEMA AND DATA
MIGRATION

DBArtisan provides advanced data management tools that help you to move schema
and corresponding table data across the same or different platforms. You can copy a
single database object, all objects owned by a specific user, or an entire database all

guided by a wizard-driven process.

Schema and Data Migration

While this example is specific to an Oracle to SQL Server schema and data migration
the same concept applies to any migration involving any combination of the supported
platforms.

To open the Schema Migration Wizard:

1. On the Utilities menu, select Schema Migration.
DBArtisan opens the Migration Wizard.

N

Select the Perform new migration option.
3. Click Next.
DBArtisan opens the next panel of the Migration Wizard.
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Migration Wizard - Step 2 of 7

Connection
Select a server and database.

Source Datasource

Select a datasource to dizplay
[? = anw character, * = any String]

Ffl S4MPLE_DATASOURCE [Oracle)

i| SCOTTY [Microsoft SOL Server)

e SCOTTY/SOLEXPRESS [Microsaft SOL
iTESTDSUSD‘I [Microsoft SOL Server]
Ha TESTDSUSO MICROSOFT #455EE (b
Ef TORLABDE221_3(IBM DB2 LW

Efl TORLABORCL10G_1 (Dracls)

s TORLABORCL10g 2 [Oracle)

Ffl TORLABORCLE_1 (Dracls)

s TORLABORCLE 2 [Dracle)

[l TORLABORCLS_1 [Dracle)
iTDHLABSQLDS_‘I [Microzoft SOL Serve

£l TORLABSY1254_2 [Sybase ASE)
i TORLABSY12_1 (Sybase ASE]
[l TORLABSY1501_1 (Sybase A5E)
< >

iTDHLABSSQLDDJ [Microzoft SQL Ser

.A.

Target Datazource

Select a datasource to display
[? = anw character, * = any String)

Sl C&PSAMP (IBM DB2 LUw) N
Bl DaLLAST [DE22/05)

ElDALLASS [DB22/05)

Bl DaLLASS [DBE2 2/05)

i Datob25 [Oracle)

i Datobym007tc IEM DBZ LUW)

i| Datoelsie [Oracle]

ﬁ'g DATOERICAT [Microsaoft SOL Server)

Bl DATOTB15ANS TANCE 3 [Microsoft 501
[l datath15_2 [Sybase ASE)

Efl datotb 16 [Sybase ASE)

i Datoth17 (MySEL)

i| DATOTETS [Microsoft SOL Server)

Ffl datotb20 [Sybase ASE)

Bl Datoth20 [IEM DBEZ LUw) ] |
i| DATOTEZY Micrasoft SOL Server] ¥
< >

[ Cancel ] [ Help ]

4. Select an Oracle datasource from the Source Datasource list and a Microsoft
SQL Server datasource from the Target Datasource list.

5. Click Next and provide login credentials if prompted.
DBArtisan opens the next panel of the Migration Wizard.

Migration Wizard - Step 3 of 7
Catalogs ™\
Select databaze(s) for the operation
Source Database Target Database

Select databazes to display
[? = any character, * = any String]

Select databases to display
[? = any character, * = any String]

] ABCDEFGHIIK1 2345673901 23456451 A
] ERSRepoRipt

] ErsRepoFipt

[J PERFCHTR_REPD_ES1E

[] PERFCNTR_REPO_UPG2

[ cases

] databasename_adddd

] labtest_cd

[] maszter

] maodel

] pett

] perfentrl

] pran_2774

[ pubs

I repo_ciinall

I repo_elena v

[¢] 2 | | [ )

Cancel ] [ Help
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Since Microsoft SQL Server supports multiple databases per datasource, you
must choose a database.

6. Select an entry from the Target Database list and then click Next.
DBArtisan opens the next panel of the Migration Wizard.

Migration Wizard - Step 4 of 7

Object Selection ™\
For each object type, select the objects that you wizh to migrate.

Object Typesz Objects
[J+}+ Check Constraints ]
[Je Clusters 7l
[14& Corfiguration Parameters
1%y Database Links
[]-m Directories
%2 Fareign Keys
[]&& Groups
[E Indeses
[Il5] Jobs
[d Libraries
[Cliis) Materislized Yiew Logs
+- i8] Materialized Views
#1758 Primany Keps
[ E Prcliles
1% RedoLog Groups
=

s Dllbnnle Commrcanke

[ < Back ” Mext » ][ Finish ][ Cancel ] [ Help ]

7. Inthe Object Types list, select the object types to be migrated to the target
datasource.

8. As you select object types, the Objects list is updated to let you select specific
objects to migrate. The Expand/Collapse icons let you drill down through
dependencies/containment.

9. Use the Obijects list to select the specific objects to migrate.

10. Click Next.

DBArtisan opens the next panel of the Migration Wizard.
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Migration Wizard - Step 5 of 7

Options ™\
Choose your migration options.

E- ‘El Example Preview
b ) . USE perfontrl fad
E Dependency Options | o |
Group Depende...  True - g

CREATE TAELE dbo.Ord:

El Script Options (

Script Drop Stat...  False
Script Object Pri...  False
Script System Pri... False
Script If Mot Existz  True
Include Storage Falze
Script Usze State...  True

order id int NOT
item_id int NOT
order id int NOT | |
CONSTRAINT ORDER!
PRIMARY EKEY {ord:

4 4 4 4 4

B Owner Options L4 )
Script Owrier True - go
Owner Retain Dwner  ~ IF CBJECT_ID("dbo.Or:
PRINT '<<< CREATI
Copy Owner False - ELSE
B Table Options DRINT '<<< FAILE|V
Usze Alter Table False - < >
Truncate Table Don't Truncate . = —
- ™| - Save Dptions Template
-
[ 5et as Default
[ < Back ” Mext » ] [ Finish ] [ Cancel ] [ Help ]

11. Examine the migration options offered but leave the defaults settings for now.
12. Click Next.
DBArtisan opens the next panel of the Migration Wizard.

Migration Wizard - Step 6 of 7
Summary N\
Thiz displays a summary of the migration that iz about to be perfarmed.

Save existing operation

C:ADocuments and S ettings\davidthapplication D ata\Embarcadero\DBAtisantDefFiles\TOR

Finizh ][ Cancel ] [ Help

Clicking Finish executes the migration and lets you view the progress of the job.

SESSION 8: PERFORMANCE MANAGEMENT

DBArtisan offers a number of different options to help you manage the performance of
your databases. First, DBArtisan ships with a built-in process monitor that helps you
understand who is connected to your database along with each user’s current activity
and session-related data. For more robust performance details DBArtisan's
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Performance Analyst add-on is a powerful client-side database monitor that runs fully
contained in the DBArtisan console.

MONITORING SESSIONS

While this example is specific to Oracle the Process Monitor is available for all of the
supported platforms.
To start the DBArtisan Process Monitor:

1. On the Datasource Explorer, select any Oracle datasource.
2. From the Utilities menu, select Database Monitor.

@ Monitor:  Processes ~ Refresh Rate zeq): 90 ﬁ z Refresh ﬁ_Toggle | ISQL 3‘ Plan (&} Session K ﬁECIose

£ 1l ] [l]
M ﬂ ﬂﬂ Processes &) Locks Blocking Locks Active Rolback Segmerts Dta Dictionary Cache Drtafile 10 General Statistics Hit Retio By User Lat
1 Mo process iz selected
Dj Explorerl I E Monitor - TORLABORCL10g_2 X j
Output Messages ﬂ
i) General | 8 Debug IEFindin Files 1 | [ Find in Files 2 |

[|Ready

Host: TORLABORCL10g_ TORLABORCL10g_2\system o T e |

The Database Monitor includes the following options and features:

Highlight any session and any currently running SQL is displayed in the
lower pane.

You can drill-down into a specific session to display session-level statistical
details, historical and current wait events along with a working copy of the
currently running SQL that can be copied to an ISQL for explain plan
generation.

By using the Monitor dropdown options you can display more advanced
database-level monitoring data such as locks, blocking locks, hit ratio by
user, Top 20 SQL etc.
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@ Monitor; | Processes Fv
|1

[
Al L
Blocking Locks

Ackive Rolback Segments
Diaka Cictionary Cache
Datafile [f0

General Statistics

Hi: R.atio By User

Latches

Library Cache

MTS Dispatcher Contention
MTS Server Contention
Open Cursors

Parallel Queries

SGA Detail

5G4 Hit Ratios b

3. Close the Database Monitor pane.

ADVANCED CLIENT-SIDE PERFORMANCE MONITORING

For advanced performance monitoring and management, DBArtisan’s optional
Performance Analyst provides intelligent diagnostic information and strong drilldown
details to help you get to the heart of any episode of performance degradation.
Performance Analyst integrates completely with DBArtisan so you can fix any
performance problems with a few clicks of the mouse.

Performance Analyst is available for Oracle, SQL Server, Sybase and DB2 for Unix,
Windows, and Linux on Open Systems.

Embarcadero Performance Analyst

1. On the Datasource Explorer, select any Oracle datasource.
On the Analyst menu, select Performance Analyst.
The Performance Analyst opens in the DBArtisan workspace for the target
datasource.
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@ Key Ratio Analysis D_EE
Efficiency Activity
4 Buffer Cache Hit Ratio 99.51 % & CPU Busy 130 %
& Procedurs Plan Hit Ratio [REE i [0 Busy 012 %
& Ad Hoo SGL Hit Ratio FL, & Server e 98558 %
& Log Cache Hit Ratio 100.00 %
100 %
9995 % f T
agao Qoo D% gt
9985 % ff T
T |I
10:34:10 000000

é_z) Bottleneck Analysis

Top System Bottlenecks

10,000
W LOCKS 8.000
M PAGE 0 LATCH 6,000
W WRITE LOG 4000
B PAGE LATCH
LATCHES 2,000
0
Walt Time (8
Error Log

Mumber of Errors in Currert Error Log: 90

Object Bottlenecks

Current Ohject Blocks 0
Deadlocks 0
Table Lock Escalations 0
Suspect Databases 0
Cffline Databases 0

Storage Bottlenecks
DB's Low on Space 1
Logs Lowe on Space o

M Active User Processes

o] SAL Analysis DE
Top For:
M Reads
W Nrites 0% 3 — e - e a—
mCPU
M Elapsed Time
Executed Statements
(= Storage Analysis DE
M Total Used  1,211.12MB
M Total Free  1,110.26 MB
Mumber of Databases: 79
Mumber of Files: 158
Mumber of File Groups: 159
8?“ Workload Analysis D_El‘
Activity SPID _Login % Used
Top CPU Process 2 s 53.86 %
Top W2 Process 54 =a 4000 %
Top Memory Process 21 NT AUTHORITYSY STEM 2.08 %

M Inactive User Processes

<l

Please see the DBArtisan online help for a detailed walkthrough of all available features

and functionality.

I[2]

For enterprise performance monitoring, DBArtisan integrates with the Embarcadero
Performance Center Web Client. While integration requires a licensed Performance
Center server, there are not upgrade requirements for the DBArtisan console.

NOTE: You should only work through the following exercise if you are a current

Performance Center user. If you are not a Performance Center customer, please read

the following for information purposes only.

Use the following to establish a quick connection to your Performance Center server:

1. On the File menu select Options.
2. On the Options Editor, select the Perf Center tab.
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Options E

Type filker text Perf Center
Datasource -
zeneral || Supply the tivity inf tion for the Emb d
Cannection Performance Center Server that you wish to use.
IDEC Connectiviy
Loggin
X 2 .g Computer Mame or [P Address:
Licensing
SMTR Mai E stoth7E v
Perf Center Fort Murnber:
Reports

Explorer an| [Use 80 you are not sure]
Debug
DDL Extract
Editaor
Results (&) weh Client () PerfCritr.exe
Grid Properties
Auto Format
\Warnings
Data Transfer
Oracle Utilities —
MwSoL Utilities
Directories
Migration Cptions
Data Editor ]

Connect to the sever uzsing:

[ u]:4 H Cancel H Help ]

Select the Web Client radio button and enter the Performance Center server info as
indicated. Perform a test to ensure the configuration is correct. After a connection is
established you can use the Tools > Performance Center option to launch the Web
Client within the DBArtisan console. If you are using the full Performance Center client
you can use this same Options editor tab to switch back.

o

D enome Qo o Roawt Ohugws B8 twot 5o S3mben Rl cose
"~ Cgiom by ot Toye N j_’réﬁ‘
T8 oAt Viome ()

P AT Y Lo

7 Dnstine g S 3k 33 3084 CAASOIOIIN Lttt by 33, 3004 13434

MERORY VAL S oy CONTINTION VITaL ows B 0 VITAL s Fy

* Buffer Cache R Ratie  97.25 % Mocked Usery o * Total Server Reads o data
* Proc Pan it Ratho 3000 * mumber of Deadlocks Mo data/d Tatal Server Writes o data
* Adboc 01K Ratio ™51 " Lock Yimeosts no data/s Log Pshes o data/s
* Log Cache it Ratin 000 * Latch Waity o data/% L0 Lrrors o data

LTI
\
i
t
\
\
\
\
\

BN VITAL 0N ™ PAcE viTaL o) o wTwORK VITAL S8 e
Total Connections " Databiuses Low On Space 1 Packets feceived o data
Active O 1 Logs Low On Space o Packets Seat Mo data
Iransactions o Logns. o data
Cwrent Locks 1 Logouts o data
| - Sovvw Lrimgren 3 OFNT R
|| T Soten Adachvn Serom /1250 MEBF 10655 LY
e >
g, O teowi ad adwt o - CRAMK T ) W | — R
il T ol @ som moseece | Ry s DV AL0QA 2w

Note the Performance Center web client provides read-only access to the monitored
datasources. To perform edits or maintenance you must switch to the full Performance
Center client.

Please see the DBArtisan online help for a detailed walkthrough of all available features
and functionality.
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SESSION 9: CAPACITY MANAGEMENT

Planning for the future of your critical databases used to be a difficult task. However,
DBArtisan’s optional Capacity Analyst tool makes it easy to understand where your
databases are today and where they are headed in the future. Capacity Analyst lets you
track key database metadata and performance metrics over time so you can perform
trend analysis on key areas like growth, object fragmentation, /0 and session load.
Like all of the Analyst Series products, Capacity Analyst runs fully contained within
DBArtisan so you have access to smart, built-in forecasting mechanisms that allow you
to predict when your databases run out of space and the ability to proactively manage
your storage assets, all from the same console.

As of DBArtisan 8.6, Performance Analyst is available for DB2 for Unix, Windows, and
Linux, Sybase, Oracle, and SQL Server.

Advanced Capacity Planning — Embarcadero Capacity Analyst
1. On the Datasource Explorer, select any Oracle datasource.
2. From the Analyst menu select Capacity Analyst.
The Capacity Analyst opens in the DBArtisan workspace for the target Oracle

datasource.
| o Cbarcidors Obkrtian 6000 - (Copacity Ansbt - [ORAVORSVSY) (M) % )
e T T T T < T -ax
ik ¥ [BoURmee o - SR, AT RuE s,
A-@F U I S DREBERzw . AETIIFTE. "R 20F NS R.
: [ 2 : A Ta MEA AABIRTU, PV GO0 X O,

Me=-Rq 40 A

B Oas = N

—

: Tt petammwce i -
TRt T At M Foom [L'A“m -

lazoim Yo | v =] A9 &

o] Lokl Dalabase Statnbxn
“iate wa Boony gotten

TATATe TAw T4 taTToe a4 Te [T 5= ¥ 4 Ce Y arv» sETIBe
-
Coogray Quenty Jgme Tesm Mg L ! Avmoge o
$
£
n? -
I »
= —
| Bronn voipn 1 Qg r b A A1 | Joncr w2 [x L e (Prrorwraw te e s 4
Aeats b

Please see the DBArtisan online Help for a detailed walkthrough of all available features
and functionality.
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SESSION 10: GENERAL UTILITIES AND TOOLS

No evaluation of DBArtisan would be complete without a mention of the general
Utilities and Tools that are available across all of the supported platforms.

UTILITIES MENU

The main toolbar Utilities menu contains the more advanced DBArtisan features. The
available menu items are context-sensitive and version-specific for the selected
datasource DBMS platform. This example shows Utilities menu features that are
available for Oracle.

Utlhtg
Bt Mirhema Extraction, .,

% Schema Migration. ..
Schema Publication. ..

a:
% DataUnload...
=2
L

| Dataload...

Database Monitaor

Dratabase Expart...

Database Import. ..

p2pd M

Archive Activity. ..
Backup Contral File. ..
Chained Row Analysis...
Free Space Deficit...

8| Instance Configuration...
Maimurm Extent Limits. ..
Pinned Code. ..
Resource Cost...
Session Informatian.. .

Top Sessions...

TOoLS MENU

The main toolbar Tools menu contains those features that are common across all DBMS
platforms. This example shows the Tools menu features that are available for all
supported DBMS platforms. Note that if any other Embarcadero products are installed
on your client they will be available in the Tools menu.
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Tools
Eﬁh ind in Files. ..
ﬂg Database Search...
@ Seript Execution Facility
% File Execution Facility
€5 sScheduler
Gl wisual DifF. .
T
2] Query Buider

S0L Profiler »
Eﬂ Irnport Data

DEZ 2J05 Server Component Installation 3

ODBC Adrministrator

&3 | performance Center

& | SQL*Plus

8| Code Workbench
} Customize. ..

All DBArtisan utilities and tools provide a common interface that walks you through all
input and execution requirements. All results are consistently presented so you can
easily move between features without effort or confusion.

ADDITIONAL RESOURCES

LICENSING YOUR EMBARCADERO TECHNOLOGIES PRODUCT

All Embarcadero Technologies products include a 14-day trial period. To continue using
the product without interruption, we recommend that you license it as soon as possible.
To license your product, use the License Request Wizard found in the Help menu of
your respective product. If you have not yet purchased your Embarcadero Technologies
product, contact sales@embarcadero.com, or uk.sales@embarcadero.com for sales in
the EMEA region.

EMBARCADERO TECHNOLOGIES PRODUCT SUPPORT

The Embarcadero Technologies Web site is an excellent source for additional product
information, including white papers, articles, FAQs, and the developer network. Click
any of the links below, to find:

e Documentation

e Product Demos

e Technical Papers

e Developer Network
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EMBARCADERO TECHNOLOGIES TECHNICAL SUPPORT

If you have a valid maintenance contract with Embarcadero Technologies, the
Embarcadero Technical Support team is available to assist you with any problems you
have with our applications. Our maintenance contract also entitles registered users of
Embarcadero Technologies products to download free software upgrades during the
active contract period. Evaluators receive free technical support for the term of their
evaluation (14 days).

We encourage you to open technical support cases via the Technical Support request
form at the Embarcadero Technologies Web site. For additional information about
Embarcadero Technologies Technical Support, go to the Support page on our Web
site.

EMBARCADERO TECHNOLOGIES ON THE WEB

To download evaluations of other Embarcadero Technologies products or to learn
more about our company and our products, visit us at www.embarcadero.com.
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